
 

 

Chapter: 11 Creating Animations in Adobe Animate 

Practice Zone (Page no 195) 

 State whether the following statements are true or False.  

 1. Locking a layer means you cannot edit the contents of the layer. -True 

 2. Making a change to one instance updates all other instances of the symbol. - True 

 3. A keyframe is frame that defines a change in the object’s properties -False 

 4. Graphics placed in top layers are placed below the graphics placed in bottom layers. -False 

 5. You cannot modify the symbols once they have been created. -False  

Assessment Zone 

A.  Choose the correct answer. 

 1. Which of the following statements does not hold true for symbols? 

  a) A symbol cab be reused. b) A copy of symbol on the stage is called 
an instance of symbol. 

c) Using symbol increases the size of 

Flash file. 

d) A symbol is stored in the library  

 2. Which of the following types of animations requires you to change the contents of every frame 
for creating an animation? 

  a) Motion tweening   b) Frame-by-frame animation 

  c) Shape tweening  d) All of these 

 3. Which of the following statements holds true for layers? 

  a) You can draw and modify the objects 

on one layer without affecting objects 
placed on another layer. 

b) You can use layers to change the order 

of the objects. 

  c) You can hide and lock layers. d) All of the above 

B.   Fill in the blanks using the words given in the box. 

 1. A symbol  is any graphic object or button that can be reused in a movie.  

 2. A key is frame that defines a change in the object’s properties. 

 3. Motion is a type of animation in which you specify the starting and editing position of an object 
in keyframes.  

 4. The red maker in the timeline that moves from left to right through the frames to display the 
complete animation of a movie is called Playhead. 



 

 

 5. In Symbol  you should not convert an object into symbol. 

C.  Answer the following questions: 

 1.  How are layers helpful  while creating pictures or animations? 

  Layers are used to organize and manage entire work by separating the content of a movie into 
manageable size. 
We can draw and modify the objects of one layer without affecting objects placed on another 
layer. 

Layer can be used to change the order of the objects. 

 2. What is a frame? 

  Frame is a basic unit in animate wherein you define the behavior or changes in the object 
properties for creating an animation. 

 3. Distinguish between: 

a) Symbol and Instance  

b) Frame-by-frame animation and Tweened animations 

 

Symbol Instance 

It is a graphic, button or movie clip that can 

be stored in the library. 

It is a copy of a symbol on the stage. 

 

Frame-by-frame animation Tweened animations 

It is a form of animation in animate the 

content of every frame for creating an 

animation  

It is the form of animation in which you 

define the contents of the first frame and the 

last frame of an animation and animate 

generates all the frames in between the two 

frames automatically. 
 

 4. What are the two types of animations? Discuss them briefly. 

Two types of animations are: 

Motion tweening 

Shape tweening  

  Motion tweening: 

Motion tweening is a type of animation that is best suited for creating movement, size, and 
rotation changes, fades and colour effects. 
This animation requires the creation of symbol. 
Shape tweening: 

Shape tweening is a type of animation in which you can convert one shape into another in order 
to create an animation in shape tweening you should convert an object into a symbol. 

 5. What is the advantage of motion presets? 

Motion preset enables us to add animations quickly with minimal number of steps. 



 

 

 6. Define masking. 

Masking feature allows to reveal only a selective of the underlying layer. 

HOTS 

A.  Tanvi has drawn a car in light blue colour and converted it to a symbol she placed an 

instance of the car on the stage and changed its colour using Tint property to dark blue.  

 1. What will be the colour of the car when Tanvi place another instance of a car on the stage? 

  Light Blue 

 2. What is the advantage of creating a symbol? 

  A symbol can be reused again and again in the movie. It reduces the file size. 

B.  Study the image and answer the question that follows. (Page No:209) 

  

 

 1. How many are there in the images layers? 

  Four layers are there in the images layers 

 2. Name the layers are that has shape tweening and motion tweening. 

  Shape tweening -sun 
Motion tweening-car 

 3.  Which layer is uneditable? 

  Ground layer is uneditable. 

 4. What is the current position of the play head? 

  11th Frame 

 



 

 

Chapter: 10 Introduction to Adobe Animate CC 2015 

Practice Zone (Page no 173) 

 State whether the following statements are true or False. 

 1. The Gap size modifier belongs to Brush tool. -False 

 2. Using the Faucet modifier of the Eraser tool, we can quickly remove the strokes or the filled 
areas of the graphic objects. - True 

 3. The Paint Bucket tool let us change the colour, thickness and style of stroke or outlines of 
shapes-False 

 4. The Eye Dropper tool can be used to copy fill and stroke attributes from the existing objects on 

the stages. True 

 5. The Straighten modifier of the Pencil tool let us draw smooth curved lines- False 

Assessment Zone 

A.  Choose the correct answer. 

 1. Which of the following tools is used to move, changes the size, skew or rotate an object? 

  a) Ink bootle tool b) Eye Dropper tool 

c) Zoom d) Free Transform 

 2. Which of the following statements is true about the Faucet Modifier?  

  a) It is a modifier of the Eraser toll that 

is used to erase the Stroke or filled 

area. 

b) It is modifier of the Brush Tool that is 
used paint the fill and empty areas 
without affecting the lines. 

  c) It is a modifier of the Paint Bucket 
Tool that is used to close gaps when 

filling areas.  

d) It is a modifier of the Lasso Tool that 
is used to select objects by drawing a 

freehand area. 

 3. Which of the following is not a drawing or painting tool? 

  a) Pencil tool b) Ink Bottle tool 

  c) Polygon tool d) Eye Dropper tool 

 4. Which of the followings modifier of the Brush tool let us paint in blank areas of stage without 
affecting the lines and fill areas? 

  a) Paint Fills  b) Paint Behind 

  c) Paint Inside d) Eye Dropper Tool 

 5. Which of the following tool can be used to copy fill and stroke attributes from the existing 
objects on the stage? 



 

 

  a) Paint Bucket Tool b) Pencil Tool 

  c) Brush Tool d) Eye Dropper Tool 

B.   Fill in the blanks using the words given in the box. 

 1. We use the selection Tool to reshape lines or outlines of shape. 

 2. The stage is an element of the Adobe Animate Interface on which all the graphic objects are 

placed.  

 3. The Ink Modifier of the Pencil Tool let us draw freehand lines with no modification applied. 

 4. The Hand Tool let us change the view of the stage without changing the magnification. 

 5. The Paint Bucket Tool let us fill enclosed areas with solid colours or gradient colours. 

C.  Answer the following questions: 

 1.  What is the significance of the following components of the window? 

  1.Timeline: It is the area where we decide graphics and other elements of a movie to create 
animation. 
2.Properties panel: It provides options for changing commonly used properties of the currently 

selected tool in the Tools panel or the selected graphic on the stage. 
This saves time as we do not have to open multiple menus or panels to change these properties. 

 2. Difference between the following tools on the basis of their use. 

Pencil Tool Brush Tool 

The Pencil Tool can be used to draw free 

form lines. 

The Brush Tool is used to create brush like 

strokes. 

There are three modifiers: 

1) Straighten 
2) Smooth 
3) Ink 

There are five modifiers: 

1) Paint normal 
2) Paint Fills 
3) Paint Behind 

4) Paint Selection 
5) Paint Inside 

 

 

Zoom Tool Hand Tool 

It is used to change the magnification level  It is used to change the view of the stage 

without changing the magnification. 

 

Selection Tool Free Transform Tool 

It is used to select objects by clicking on an 

object or by enclosing the object within a 

rectangular selection marquee.  

It is used to select objects by drawing a 

freehand area. 

 

Paint Bucket Tool  Ink Bottle Tool 



 

 

It is used to fill enclosed areas while drawing 

or painting a figure. 

It is used to change the colour, thickness and 

style of strokes or outlines of shapes. 
 

   

D.  Choose the odd one out. 

 1. Zoom tool, Rotation tool, Lasso tool , Hand tool 

 2. PolyStar tool, Rectangle tool, Oval tool, Polygon tool  

 3. Lasso tool, Selection tool, 3D rotation tool, Pencil tool  

 4. Straighten modifier, Faucet Modifier, Ink modifier, Smooth Modifier 

HOTS 

  Crossword-Tools Power 

Identify the tool write its name.  

  Down Across 

  1.Line 2.Lasso 

  3.Eraser 4.Free transform 

  5.Ink Bottle 6.Rotation 

  9.Zoom 7.Polystar 

  10.Pencil 8.Selection 

  11.Oval 12.Brush 

   13.Text 

 



 

 

Chapter: 9 Creating Movies using Movie Maker 

  

Practice Zone (Page no 137) 

 State whether the following statements are true or False. 

 1. Movie Maker comes as part of Microsoft Office Suite. – False 

 2. Using Movie Maker, you can edit and arrange audio and video content to create movies or 
presentations. – True 

 3. Movies created in Movie Maker can only be seen on desktop computer and cannot be shared 
on YouTube and other platforms. – False 

 4. The storyboard pane is used to rearrange the order of clips or pictures in a movie. – True 

Activity Zone: 

 Name the tab and option/group name you will use to perform the following tasks in movie 

maker. 

 
 

To do Tab Name Option / Group Name 

1. To put text over the selected 
picture. 

Home Add  Caption 

2. To introduce a picture from 
the left corner when playing 
the movie 

Animations Transitions 

3. To provide information 
about the director and star 
cast at the end of the movie 

Home Add  Credits 

4. To zoom a picture when 
playing the movie 

Animations Pan and Zoom 

5. To make a colored picture 
appear black and white 

when playing a movie 

Visual Effect Effects 

Assessment Zone 

A.  Choose the correct answer. 

 1. ______________control the way how a video clip/picture is introduced when the movie is 
played.  

  a) Visual effects b) Transitions 

c) Credits d) Caption  

 2. Which of the following option will you use to display text over the selected picture or video 
clip? 



 

 

  a) Credits  b) Titles 

  c) Caption d) Transitions 

 3. The option to add pan and zoom effects is present on which of the following tab? 

  a) Home b) Animations 

  c) Project d) Visual effects 

 4. Which of the followings operations can be carried out after you have added audio in the movie? 

  a) You can adjust the volume of audio b) You can fade in or fade out the music 
in the audio. 

  c) You can change the position of the 
audio from one place to another in the 
Storyboard Pane 

d) All of the above 

B.   Fill in the blanks using the words given in the box. 

 1. The animations tab provides options to add transitions to introduce pictures/video clips in a 
movie. 

 2. Title is the text added before the selected picture in the movie and credits is the text added at 
the end of the movie. 

 3. The project tab provides options for emphasising the audio/narration/video/when you have 
multiple media source playing simultaneously  

 4. Artistic, Black, And White, Cinematic, Mirror, Motion and Fades are types of visual  effects. 

 5. Splitting a video clip helps in dividing a long video clip into two parts.  

C.  Answer the following questions: 

 1.  What is the use of movie Maker software? 

  →Movie maker is a video creating and editing software. 
→This software allows us to edit and arrange audio and video content to create movies or 
presentation. 

→It includes features such as visual/effects, transitions, titles or credits, audio and narration 

 2. Give one task each that can be performed in Preview Pane and Storyboard Pane of the 

Movie maker window. 

  →Preview Pan is used to preview the pictures, video, clips, visual effects and transition added 
by you to create a movie. 
→Story board Pane is used to displays the sequence of video clips or pictures in the project. 

 3. What is the difference between visual effects and transitions? 

 

Visual effects Transitions 



 

 

Visual effects will change the look and feel 

of the picture or the video clip. 

Transition effects controls the way how a 

video clip/picture is introduced when the 

movie is played 

E.g. Mirror, Motion, Fades E.g. Sweeps & Curls, Wipes, Reveals 
 

 4.  What is the significance of Save movie option in the share group on the Home tab? 

  Movie maker provides various options to save movie for high definition display, for mobile  
Phone, for tablets and for web sites such as YouTube, Vimeo and so on. 

HOTS 

  Look at the figure and answer the following questions.  

  Page No: 155 

 1. How many pictures and video clips are added in the project? 

Two pictures and two video clips are added in the project. 

 2. Name the element(s) used to display text in the movie. 

Caption, Credits and Title are the elements used to display text in the movie. 

 3. State whether audio has been added in the movie or not. 

Yes, audio has been added in the movie 

 4. State whether the pan and zoom effects have been incorporated in the movie. 

Yes, the pan and zoom effects have been incorporated in the movie. 

 5. Which interface element of the Movie Maker can be used to preview the animation 

incorporated in the movie? 

Preview Pane is used to preview the animation incorporated in the movie. 

 



 

 

Chapter: 8 Internet Services 

Practice Zone (Page no. 122) 

 Fill in the blanks. 

 1. Internet is a world wide network of computers. 

 2. Bing and Google are examples of Search Engine. 

 3. Pictures, documents or files sent along with email message are known as attachment. 

 4. Yahoo Messanger and Google Hangout are two commonly used software for chatting. 

 5. An unwanted email sent to numerous people is called spam mail. 

Practice Zone (Page no. 130) 

 1. Twitter is an example of Social Networking site. 

 2. Flipkart.com is an example of E-Commerce site. 

 3. DigiLocker and MyGov.in are examples of two services under the Digital India campaign. 

 4. RSS stands for Rich Site Summary or Really Simple Syndication 

 5. A person who maintains a blog is known as a blogger. 

 

Assessment Zone 

 

A.  Choose the correct answer. 

 1. ___________ is an instant messenger that is used for chatting. 

  a) Google Talk b) Microsoft Excel 

  c) Microsoft Windows d) Altavista 

 2. Which is the odd one out? 

  a) Facebook b) Twitter 

  c) Lycos d) LinkedIn 

 3. Real-time textual communication between two users using computers is known as 

  a) Chat b) Email 

  c) Newsgroup d) Social networking site 

 4. They are known as online bulletin boards where users can post messages that can be seen 

by everybody. 



 

 

  a) Video conferencing b) Newsgroups 

  c) Email d) Search Engine 

 5. It is the technology that lets organisations cut costs by making use a network of remote 

servers hosted on the Internet to store, manage and process data. 

  a) e-learning b) Video Conferencing 

  c) Chatting d) Cloud computing 

 6. The online facility that lets you track the sytatus of your EPF account or Aaadhar card is 

an example of  

  a) e-governance b) E-awareness 

  c) E-learning d) E-commerce 

 7. Which of the following is not covered under the Digital India campaign? 

  a) Digital Locker b) Swachh Bharat Mission (SBM) 
Mobile app 

  c) Buying and selling of goods online d) National Scholarships Portal 

B.   Fill in the blanks using the words given in the box. 

 1. You can find information with the help of a search engine 

 2. Emoticons are the symbols that are used to express emotions in texual messages. 

 3. Buying and selling of goods and services through the Internet is known as e-commerce. 

 4. Social networking sites are a great tool to find old friends and stay in touch with them. 

 5. A website that contains diary-like entries in the reverse chronological order is called a blog. 

 6. You can use dropbox to store files and access them from any computer or mobile phone with 

Internet access. 

 7. RSS and Atom are two web feed formats. 

C.  Answer the following questions. 

 1. What is a search engine? Give any two example. 

 → A search engine is a software that searches the webpages for information on a particular topic. 

 → Some popular search engines are Google, Yahoo! Search, Bing, Altavista and Lycos 



 

 

 2. Differentiate between the CC and BCC options used in emails. 

CC BCC 

It stands for Carbon Copy. It stands for Blind Carbon Copy. 

This field allows you to direct a copy of your 
mail to the secondary recipients. 

This field is ment for the secret recipients. 

In this case, every recipient will be able to 
see all the other recipients who have 
received the mail. 

The email addresses mentioned in the BCC 
field are not visible to the other recipients of the 
email. 

 

 3. What is the structure of an email address? 

 → An email address consists of a username and a domain name of the server that provides the 
email facility. 

 → The username and the domain name are separated by the symbol @. 

 → For example, in the email address kumar@gmail.com, the username is kumar and the domain 
name of the server is gmail.com 

 4. Give the advantages of video conferencing. 

 → Video conferencing is very useful for business meetings, educational trainings and health care 
conferences. 

 → People at geographically separatedlocations can see and hear each other using microphones, 

cameras, speakers and a TV or a computer screen. 

 5. What is a blog? 

 → The word blog is a short form for the word weblog. 

 → A blog is a website or part of a website that contains personal diary-type entries in the reverse 
chronological order. 

 6. What is cloud computing? What are its advantages? 

 → Cloud computing is a technology that makes use of a network of remote servers available on 
the Internet to store, manage and process data, rather than a local server. 

  Advantages: 

 → You pay only for the services and not for the hardware and the software. 

 → You have online access to a broad range of applications, services and hardware that otherwise 
may be very expensive. 

 → You cut costs by renting software and applications. You do not have to worry about buying 
software or upgrading it from time to time. 

 → High infrastructure investments are replaced by low monthly costs. 

   

 

mailto:kumar@gmail.com


Chapter – 5  Looping Statements in QBASIC 

Practice Zone (Page no 77) 

 Consider the following programs and choose the correct answer. 

 1. FOR I = 1 TO 10 STEP 2 

PRINT I 

NEXT I 

 → The output of the program is: All odd numbers from 1 to 10 

 2. FOR A = 50 TO 1 STEP -1 

PRINT A 

NEXT A 

 → The output of the program is: Numbers from 1 to 50 in descending order 

Practice Zone (Page no 81) 

 Write a program to display your name multiple times using DO WHILE … LOOP. 

  REM write a program to display your name multiple times using DO WHILE ... LOOP. 
CLS 
i = 0 
DO WHILE i <= 10 
    PRINT "My name is Prutha" 

    i = i + 1 
LOOP 

Assessment Zone 

A.  Choose the correct answer. 

 1. Which of the following looping statements is most suitable when several statements have 

to be executed a fixed number of times? 

  a) DO WHILE …LOOP b) DO UNTIL … LOOP 

  c) FOR … NEXT d) None of these 

 2. The default value of the step value is ___________ 

  a) 1 b) 0 

  c) -1 d) None of these 

 3. The step value can be __________ 

  a) a positive value b) a negative value 

  c) a decimal value d) All of these 

 4. How many times will the following loop be executed? 

X = 0 



DO WHILE X > 10 

PRINT “*” 

LOOP 

  a) 10 b) 5 

  c) 0 d) 9 

 5. In a FOR … NEXT loop, if the final value is less than the initial value, then the STEP 

value should be __________ 

  a) Positive b) Negative 

  c) Zero d) None of these 

 6. What will be the output for the following program? 

FOR V = 1 TO 10 

NEXT V 

PRINT V 

  a) 1 b) 10 

  c) 11 d) None of these 

B.   Write the value taken by the control variable in the following FOR 

statements. 

  FOR statement Values 

1. FOR X = 5 TO 10 STEP 2 5, 7, 9 

2. FOR X = 20 TO STEP -5 20, 15, 10, 5 

3. FOR X = 100 TO 105 100, 101, 102, 103, 104, 105 

4. FOR X = 4 TO 6 STEP 0.5 4, 4.5, 5, 5.5, 6 
 

C.  Find errors in the following programs and write the correct code. 

 1. FOR R = 1   , 5 

PRINT R 

NEXT A 

→ FOR R = 1 TO 5 

PRINT R 
NEXT R 

 2. X = 1 

DO   LOOP    X < 5 

PRINT X 

X = X + 1 

WHILE 

→ X = 1 
DO WHILE X < 5 
PRINT X 
X = X + 1 
LOOP 

D.  Answer the following questions. 

 1. What is a loop? How can you create loops in QBASIC? 

 → A loop is used to repeat the execution of a group of statements many times. 

 → We can create loops in two ways in QBASIC: 

  1. FOR … NEXT 



2. DO … LOOP 
a. DO WHILE … LOOP 
b. DO UNTIL … LOOP 

 2. What is the use of step value in a FOR … NEXT loop? 

 → Step value is the value by which the counter variable is incremented or decremented every time 
the loop body is executed. 

 → It can be a positive or a negative value, but it cannot be zero. 

 → The step value is optional. 

 → The default step value is 1. 

 3. How is a DO WHILE … LOOP different from DO UNTIL … LOOP? 

 → The DO UNTIL … LOOP is similar to the DO WHILE … LOOP, the only difference between 
the two loops is that in the DO UNTIL … LOOP, the execution of the loop continues as long 

as the condition is false. 

 4. Give the significance of the EXIT DO and EXIT FOR statement. 

 → You can exit from FOR … NEXT loop using EXIT FOR statement. 

 → You can exit from DO … LOOP using EXIT DO statement. 

 5. What should be the step value in the following code? 

REM Display nultiples of 3 

FOR I = 3 TO 30 STEP  ___ 

NEXT I 

 → 3 

E.  The following program was written to display even numbers between 4 to 44 in reverse 

order. The program is not giving the desired output. Identify and correct the mistake in 

the program. 

 → REM Program to display even numbers. 
FOR X = 44 TO 4 STEP 4     -2 
PRINT X 
NEXT X 

HOTS 

 Study the image and answer the questions that follow.  

 There are 10 residents in a society. The program deals with the residents of the society. 

 1. What does the above program do? 

 → The program shows total number of car owners. 

 2. What is the step value in the FOR … NEXT loop? 

 → 1 



 3. How many times will the loop run? 

 

 → 10 

 4. What statement should be added to the program to 

display the count of residents who do not own a 

car? 

 → PRINT “Residents who do not own a car:”; 10 – count 

    

 



Chapter: 4 Advanced Features of Microsoft Excel 2013 

Assessment Zone 

A.  Choose the correct answer. 

 1. Which of the following feature in Excel lets you format the cells when the cell contents 

satisfy a particular condition? 

  a) Sorting b) Custom Filtering 

  c) Conditional Formatting d) Cell Formatting 

 2. Which of the following statement holds true for custom filtering in Excel?  

  a) This option lets you change the background colour of the basis of satisfaction of a 
condition. 

  b) This option lets you view selective rows that satisfies more than one condition for 

a column. 

  c) This option lets you arrange data in ascending or descending order. 

  d) This option lets you generate series of data. 

 3. Which of the following statements is not true about sorting data in Excel?  

  a) You can sort data in rows on the basis 
of text, numbers or dates. 

b) You can sort data in ascending or 
descending order. 

  c) You cannot sort data by more than 

one column. 

d) You can exclude header rows from 
sorting. 

B.  Fill in the blanks using the words given in the box. 

 1. The conditional formatting feature of Excel lets you apply formatting to a cell only when the 

value in the cell satisfies a given condition. 

 2. The option to apply conditional formatting is available on the home tab. 

 3. The filtering features lets you temporarily hide the rows that do not meet the specified 
condition. 

 4. Using custom filter, you can display data that satisfies more than one condition for a column. 

C.  Answer the following questions. 

 1. What is the use of sorting feature in Excel? How is it different from Filtering feature? 

 → Sorting allows you to arrange data in a particular order whereas filtering allows view selective 
data that meets a certain criterion. 

 2. What is custom filtering? 

 → Custom filter is used to display data that satisfies more than one condition for a column. 



 3. Discuss the two ways in which you can specify the conditions when filtering feature?  

 → Number Filter and Text Filter are the two ways in which you can specify the conditions when 

filtering data. 

 → Number filter appears as we are filtering on the basic of number-based column. 

 → Text filter appears as we are filtering on the basic of text-based column. 

 4. How is conditional formatting useful to us? Name the tab that contains the option for 

applying conditional formatting. 

 → Conditional formatting is a feature in Excel that allows apply formatting, such as cell shading 
or font color to a cell when the cell contents satisfy a given condition. 

 → Conditional formatting option is available in Styles group on the Home tab. 

HOTS 

 Study the given image and answer the questions that follow: 

 1. Which feature of Excel will you use to 

arrange the data in the descending order of 

names of students? 

 

→ Sorting 

2. Which feature of Excel will you use to view 

only the names and grades of students who 

have opted for ‘Computer’ as an activity? 

→ Filter 

3. Which feature of Excel has been used to 

highlight the cells having Grade ‘A’ in the 

column ‘Grade’? 

→ Conditional Formatting 

  

   

 



Chapter: 3 Charts in Microsoft Excel 2013 

Practice Zone (Page no: 42) 

 Match the following. 

 

 Component of a chart Purpose 

1. Plot area An area containing the chart, axes and gridlines. 

2. Data marker Any symbol such as a bar, an area, a dot or a slice used 
to represent a value in a chart. 

3. Axes The horizontal and the vertical lines that surround the 
plot area used as reference points for measuring the data 
values being plotted on the chart. 

4. Gridlines The horizontal or the vertical lines in the plot area used 
to identify the value of each data point on the chart. 

5. Legend A box containing a unique pattern or color to identify 
each data series on a chart. 

6. Chart area An entire area containing the chart and all its elements. 
 

Practice Zone (Page no 46) 

 Suggest the suitable type of chart for plotting the following. 

 1. To compare the production of various items such as rice, wheat, barley over a period of 

three years. 

 → Column Chart 

 2. To depict the size of items in one data series, proportional to the sum of the items sold by 

a company. 

 → Pie Chart 

 3. To display the trends in the demand of refrigerators over a period of last five years. 

 → Line Chart 

Assessment Zone 

A.  Choose the correct answer. 

 1. Identify the component of the chart helps in identifying various plotted data series by 

assigning a unique color or pattern to a particular data series. 

  a) Chart title b) Axes 

  c) Plot area d) Legend 



 2. Which of the following charts plot the data series as rings? 

  a) Bar Chart b) Line Chart 

  c) Pie Chart d) Doughnut Chart 

 3. Identify the chart that uses connecting dots to depict the trends over a period of time. 

  a) Line Chart b) Pie Chart 

  c) Bar Chart d) Doughnut Chart 

 4. The horizontal or the vertical lines in the plot area that help us in easily identifying the 

value of each data point on the chart is cal led  _____________. 

  a) Gridlines b) Axes 

  c) Chart Title d) Legend 

B.  Fill in the blanks using the words given in the box. 

 1. The option to add charts in the worksheet is present under the Insert tab. 

 2. Any symbol such as a bar, an area or a slice used to represent a value in a chart is called data 

marker 

 3. The bar chart represents values on the horizontal axis and categories on the vertical axis. 

 4. The design tab shows inbuilt chart styles. 

 5. The relationship of individual items to the sum of all items in the series can be represented 
using the pie chart. 

C.  State whether the following statements are True or False. 

 1. Doughnut chart can plot only one data series. - False 

 2. Once added, we cannot change the look and feel of the chart. - False 

 3. We can give titles to the x-axis and y-axis. - True 

 4. We can change the location of the placement of the chart. - True 

 5. Bar charts represent categories on the y-axis and values on the x-axis.  - True 

D.  Answer the following questions. 

 1. What is a chart? What are the advantages of charts? 

 → Charts are graphical representation of worksheet data. 

 → Charts makes it easier for users to quickly understand, compare and find patterns and 
relationships between worksheet data. 

 2. What is the use of gridlines and legends in a chart? 

 → Gridlines: The horizontal or vertical lines in the plot area of a chart. 



 → Legends: A box that helps in identifying various plotted data series by assigning a unique color 
or pattern to a particular data series in a chart. 

 3. What is the difference between a bar chart and a column chart? 

Bar Chart Column Chart 

It displays the comparisons among individual 
items as sets of horizontal bars. 

It is used to depict comparisons among 
different items of data or changes in data 
trend over a period. 

The values are represented on the horizontal 
axis whereas categories are represented on 
the vertical axis. 

The values are represented on the vertical 
axis whereas categories are represented on 
the horizontal axis. 

 

HOTS 

 Study the following chart based on the number of packages sold by a Tours and Travels 

company to the various destinations in the last four months and answer the questions that 

follow: 

 1. Identify the type of chart. 

 → Column chart 

 2. A legend has been placed in the chart. Identify its position. 

 → Right side. 

 3. What are the numbers on top of every bar known as? 

 → Data label 

 4. What are the lines running across the plot area known as? What is their use? 

 → Gridlines 

 → They are used to identify the value of each data point on the chart. 

 5. Identify two months in which the company sold maximum number of packages for 

Mauritius. 

 → Feb and March 

 6. Name the tab and option you will use to change the style of the chart. 

 → Chart Styles group on Design Tab 

   

 



 

 

CH-1 COMPUTER FUNDAMENTALS 
 

ASSESSMENT ZONE 

 

 

A Choose the correct answer. 

 

1. Which type of software converts and executes the source code of a high-level language 

program line by line? 

a) Compiler                                               b) Interpreter 

c) Assembler                                                     d) Operating System 

 

 

2. A type of software that allows the source code to be accessible to the users and organizations are 

called ____________. 

a) Proprietary software                                 b) Open-source software 

      c) Desktop Publishing software                     d) Language Processors 

 

 

3. 
A software program that let us store large amounts of data in an organized manner and 

provides tools for searching data and generating reports based on conditions is called 

___________. 

a) Spreadsheet software b) Desktop Publishing software 

      c) Graphic software d) Database Management software 

 

 

4.  Which among the following is the largest unit of measurement of memory? 

a) Petabyte                 b) Gigabyte 

c) Yottabyte d) Terabyte 

 

  

B  Fill in the blanks using the words given in the box.  

  

1. The operating system is an interface between the user and the hardware. 

2. Proprietary software is a computer software for which there are restrictions on use, 

modification, copying or redistribution. 

 

3. One petabyte is equal to 1024 Terabyte whereas one zettabyte is equal to 1024 Exabyte. 

 

4. The utility software performs maintenance work on a computer system to help in its smooth 

functioning. 

 

5. Ubuntu, an Operating System, is an example of open-source software. 



 

 

  

 

 

C Choose the odd one out. 

 

1. Compiler, Assembler, Interpreter, Disk Cleanup 

 

2. Linux, Windows, Android, Access 

 

3. Billing System, iOS, Ticketing System, Inventory Control System 

 

4. QuarkXPress, Photoshop, Antivirus, Excel 

 

5. Mozilla Firefox, Openoffice.org Writer, Audacity, Adobe InDesign 

 

6. Visual FoxPro, Access, Oracle, PowerPoint 

 

  

D State whether the following statements are True or False. 

 

1. A computer can work without an operating system. - False 

 

2. Application software is used to control the operations of a computer. - False 

 

3. High-level language programs have to be converted to machine language using an interpreter 

or compiler. - True 

 

4. An antivirus program is an example of utility software. - True 

 

5. Payroll software is an example of general purpose application software. – False 

 

  

E Convert the following decimal numbers to their equivalent binary form. 

 

1. (126)10 = (1111110)2 

 

2. (76)10 = (1001100)2 

 

3. (172)10 = (10101100)2 

 

4. (512)10 = (1000000000)2 

 

  

F Convert the following binary numbers to their equivalent decimal form. 

 

1. (111110)2 = (62)10 

 

2. (110001)2 = (49)10 

 



 

 

3. (1010011)2 = (83)10 

 

4. (11101011)2 = (235)10 

 

  

G Answer the following questions. 

 

1. Differentiate between the following: 
 

Ans. (a) High level language and Machine level language 

 

High Level Language Machine Level Language 

It is the language in which programs are 

written using English like words and 

mathematical symbols.  

 

It is the language in which instructions are 

given in the form of strings 0’s and 1’s. 

Translators are used for converting high- 

level language programs into 

corresponding machine language. 

 

No translators are needed as is directly 

understood by the computer. 

It is very easy for programmers to learn 

and use high-level language. 

Complete knowledge of computer 

architecture is required to write program in 

machine language. 

 

(b) Compiler and Interpreter 

 

Compiler Interpreter 

It converts a high level program into 

machine language in one go. 

An Interpreter is a language processor 

that works by reading and executing the 

source code of a high - level language 

program line by line. 

 

It stores the converted object code of a 

program. 

 

Here, object code of a program is not 

saved. 

The saved object code can be executed 

number of times without translating it 

again. 

Every time the program is run, it needs to 

be interpreted again to obtain the object 

code. 

 

(c) System software and Application software 

 

System software Application software 

System software is required to control the 

operations of a computer system. 

 

Application software is a set of programs 

designed to help the user to perform 

specific tasks. 

 



 

 

It can be classified into three categories: 

1. Operating System 

2. Language Processors 

3. Utility Software 

It can be classified into two categories: 

1. General Purpose 

Application Software 

2. Specific Purpose Application 

Software 

 

Examples: Linux, Compiler, Quick Heal, 

WinRAR 

Examples: Word 2013, Oracle, Adobe 

InDesign, Impress 
 

 

2.  

 

What are the two categories of application software? Name and define them by giving 

suitable examples of each. 

 

 

Ans. Application software can be divided into two categories: 

1. General purpose application software 

2. Specific purpose application software 
 

1. General purpose application software: 

General purpose application software is developed keeping in mind the needs and 

requirements of general people. 

 

Examples: 

✓ Word processing software 

✓ Spreadsheet software 

✓ Database Management System 

✓ Desktop Publishing Software 

✓ Graphics, Multimedia and Presentation Software 

 

2. Specific purpose application software: 

Specific purpose application software is developed keeping in mind the requirements of an 

organization or an individual. 

 

Examples: 

✓ Accounting Management Software 

✓ Reservation System 

✓ Human Resource Management System 

✓ Attendance System 

✓ Payroll System 

                                                     

3. Name any two functions performed by operating system. 

 

Ans. Listed below are the functions of an operating system. 

 

1. Operating system serves as an interface between the user and the hardware. 

2. It provides an environment in which user executes programs. 

3. It ensures that the computer hardware is used in an efficient manner. 

4. It acts as a resource manager by allocating resources to specific programs and applications 

as and when required.  

 



 

 

4.  What is the advantage of an open-source software? Give two examples of open-source 

software. 

 

Ans.  Open-source software allows the source code to be accessible to the users and organizations   so 

that they may study and change it to achieve and build new versions of the software 

incorporating their changes.  

Examples: 

✓        Ubuntu ✓ Mozilla Firefox ✓ OpenOffice ✓ Android 

✓ Audacity ✓ VLC ✓ GIMP ✓  
 

 



 

 

CH-2 CALCULATIONS IN MICROSOFT EXCEL - 2013 
 

ASSESSMENT ZONE 

 

A Choose the correct answer. 

 
 

1. Which of the following is the symbol for multiplication in Excel? 

a) /                                                            b) ^ 

c)  *                                                           d) & 

 

2. An error that occurs when a formula contains invalid data is 

a) #VALUE!                                 b) #NAME? 

c) #DIV/0!                                          d) ##### 

3. Which of the following is the correct way of specifying arguments to a function? 

a) =SUM [A1:A5] b) =SUM{A1:A5} 

c) =SUM (A1:A5)                                 d) =SUM (A1-A5) 

 

4.  Which is the correct way to concatenate two text values contained in cells A1 and B1 in Excel? 

a) =A1 & B1 b) = A1 + B1 

c) A1 & B1                                              d) A1 + B1 

 

  

B  Fill in the blanks using the words given in the box.  

 
 

1. The cell references containing values to be used for calculations passed to the function are    

called arguments. 

 

2. Excel displays the error value #NAME? when a formula is not spelt correctly. 

  

3. The product function is used to multiply the contents of the cells. 

 

4. Operators specify the type of operation you want to perform. 

 

5. The AutoSum feature is particularly useful when you want to add numbers in a contiguous   row 

or column quickly. 

 

6. To calculate the number of numeric entries in a range of cells, you use the count function. 

 

 



 

 

 

 

C  Write the formula to calculate the following. 

 
 

1. 
To add the contents of cells B2, B3, B4 and B5 and divide the sum by the contents of cell C7. 
 

Ans. =(B2+B3+B4+B5)/C7 

 

2. To multiply the contents of the cells C12 and C13 and then divide the product by the contents of the 

cell D18. 
 

Ans.  =(C12*C13)/D18 OR =PRODUCT (C12:C13)/D18 

 

3. To subtract the contents of the cell A6 from the contents of the cell B6 and then multiply the 

difference with the contents of the cell C6. 
 

Ans. =(B6 - A6)*C6 

 

4. Selecting the maximum value out of a range A1 to B20. 

 

Ans.  =MAX(A1:B20) 

 

5. Calculating average of marks entered in cells E5, F5, G5, H5 and I5. 
 

Ans.  =AVERAGE(E5:I5) 

 

6. Calculating total expenses incurred if expenses are given month-wise in cells A1, B1, C1 and D1. 
 

Ans. =SUM(A1:D1) 

 

 
 

D  Answer the following questions.  

 
 

1. Define formulas. 

 

Ans.  Formulas are expression in Excel containing constants, cell reference, functions and/or operators 

that let you perform calculations in a worksheet.  

 

2.  What are operators? List the use of some operators used for calculations in Excel. 

 

Ans.  Operators are the special symbols such as +, -, &, etc., used for specifying the type of operation to 

be performed. The different types of operators include the arithmetic and the text operators.  

 

 



 

 

Arithmetic operators: 

 

Operator Description 

+ Adds tow numbers 

- Subtracts second from first number 

* Multiplies two numbers 

/ Divides first number by second number 

^ Raises a number to a power 
 

  

Text operator:  

 

Operator Description 

& Joins or concatenates two or more text strings 
 

3.  What is the significance of AutoSum feature? Name the tab containing this option. 

 

Ans.  The AutoSum (Σ) feature let us calculate the sum of data arranged in contiguous rows or column 

quickly. The AutoSum option is available at following two places. 

 

1. In the Editing group on the Home tab. 

2. In the Function Library group on the Formulas tab. 

 

4. Define Functions. Discuss its structure. 
 

Ans.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Functions are predefined formulas that can be applied directly to perform calculations in Excel. 

 

Structure of Function: 

 

A function in Excel has three parts. 

 

1. Equal to sign (=): All functions must start with an equal to sign. 

 

2. Function Name: It is the name of the function that help us in specifying the type of 

operation to be performed on the values. 

 

3. Arguments: The cell references containing values passed to a function to be used for 

calculations are called arguments. They are always written in between of opening ’(‘ and 

closing ‘)’ parentheses. 

 
Example: = SUM (A1:A5) 

 

 

 

 

Equal to sign 

Function Name 

Arguments 


	7 Chapter 11 Creating Animations in Adobe Animate.pdf (p.1-3)
	7 Chapter 10 Introduction to Adobe Animate CC 2015.pdf (p.4-6)
	7 Chapter 9 Creating movie using movie maker.pdf (p.7-9)
	a5d426ee-87c2-4fcd-8776-7e443e4b9ff5.pdf (p.10-29)
	7_Computer_Chapter_8_Internet_Services.pdf (p.1-3)
	b7f3606f-4d3b-4a4f-b8b4-d7268751516b.pdf (p.4-20)
	Class 7 computer chapter 5  Looping Statements in QBASIC.pdf (p.1-4)
	com merge.pdf (p.5-17)
	Class 7 computer Ch 4 Advance features of MS excel 2013.pdf (p.1-2)
	6bea3208-4c1a-4732-9796-02059ab6489a.pdf (p.3-13)
	Class 7 computer chapter 3 Charts in Microsoft Excel-2013.pdf (p.1-3)
	computer.pdf (p.4-11)
	CLASS-7  computer CH-1 Computer Fundamentals.pdf (p.1-5)
	CLASS-7  computer CH-2 Calculation in EXCEL-2013.pdf (p.6-8)






